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models dw220, dw222, dw223,  
dw225 & dw226 !

    Installation & Operation Manual

speedydrive.web
Distributed Process Controller

speedy, savvy, savvyPanel, smarty, Bardac and drive.web are trade marks of  Bardac 
Corporation, registered in the U.S. and other countries. 
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EMC Standard, EN 61326-1: 2006, Electrical Equipment for Measurement, Control and 
Laboratory Use. 

	 Emissions Class A, Commercial Equipment. 
	 Immunity Table 2, Industrial Equipment. 
LVD Standards, EN 61010-1: 2010, Safety Requirements for Electrical Equipment for 

Measurement, Control and Laboratory Use and;  
	 EN 61010-2-030: Particular Requirements for Testing and Measuring Circuits. 
speedy is an industrial controller designed for permanent installation by qualified 

professionals. If  it is used in a manner not specified herein the protection provided may be 
impaired. 

speedy and its packaging contain recyclable materials and a small rechargeable battery, 
classed as “portable”, that is permanently affixed to the underside of  the main circuit board.  
The battery must be removed with wire-cutting pliers and separated for proper disposal. 

This device complies with Part 15 of  the FCC Rules. Operation is subject to the following two 
conditions: (1)This device may not cause harmful interference, and (2)this device must 
accept any interference received, including interference that may cause undesired operation. 

This Class [A] digital apparatus complies with Canadian ICES-003.  Cet appareil numerique 
de la classe [A] est conforme à la norme NMB-003 du Canada. 

Warning! It is essential that you read and understand this entire manual and the entire 
contents of  the savvy software Help menu before proceeding with your installation and 
configuration. See page 7 for savvy installation instructions. For more information and to 
download manuals and software, go to www.driveweb.com or contact us. See page 20. 

Warning! Your use of  savvy software and drive.web devices may cause motors and 
machinery to power up with high Voltages or start or operate in an unexpected, dangerous or 
lethal way. It is essential that you are completely familiar with all of  the equipment and the 
system design before attempting to program or edit a program or connect to any live device. It 
is also essential that a risk assessment is conducted to identify hazards. Risks must be reduced 
to tolerable levels. 

Warning! You are entirely responsible for the configuration or use of  any drive.web 
product. By configuring or using these products you agree to indemnify and hold harmless 
Bardac Corporation, its’ employees, directors, officers, distributors and resellers against the 
consequences of  your configuration or use of  the products. 

Warning! Information in this manual is subject to change without notice. You are 
responsible for verifying the proper operation of  your speedy module. Special care must be 
taken after loading new firmware or installing new options.!

Warning! Avoid permanent damage to your speedy, never exceed any min or max 
values.  Do not connect any speedy terminal to mains circuits. See page 4 for details.  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lwIP is incorporated into speedy firmware. lwIP Copyright (c) 2001-2004 Swedish Institute of  Computer Science. All rights reserved. 
Redistribution and use in source and binary forms, with or without modification, are permitted provided that the following conditions are met: 
1. Redistributions of  source code must retain the above copyright notice, this list of  conditions and the following disclaimer. 
2. Redistributions in binary form must reproduce the above copyright notice, this list of  conditions and the following disclaimer in the 
documentation and/or other materials provided with the distribution. 
3. The name of  the author may not be used to endorse or promote products derived from this software without specific prior written permission. 
THIS SOFTWARE IS PROVIDED BY THE AUTHOR ``AS IS'' AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO, PROCUREMENT OF 
SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER 
CAUSED AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING 
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGE.

  Conformity Statements:



drive.web automation

Product identification, speedy model number!
speedy is a programmable device using drive.web 

distributed control over Ethernet for industrial 
process automation. To program and use a speedy 
you must get the savvy software tools from 
www.driveweb.com. Please see pages 7 to 11. 

To find the speedy‘s firmware version, launch savvy 
and choose Get Detailed Info from the speedy 
contextual menu. See pages 11.  

dw220 generic ModbusRTU master up to 500kbps. 
dw222 for Optidrive E2 variable frequency drive. 
dw223 for Optidrive Plus open-loop vector drive. 
dw225 for Yaskawa YF7 inverter drive. 
dw226 for Optidrive HVAC variable-torque AC pump and fan drive. 
speedy standard features 

drive.web distributed process control. 
10/100Base-T(X) Ethernet, page 6. 
Update firmware with savvy software. 
Ultra-compact, may be permanently bonded inside equipment. 
High-speed ModbusRTU on EIA485. dw220 up to 500kb/s. 
Basic Control Function Block Library.  

speedy options  
Software options may be added using savvy. See page 12. 
See savvy User Manual for up-to-date function block listings. 
04 ModbusTCP/IP Slave/server. See page 18. 
05 Process Control Recommended for most applications. 
06 Winder Control See page 19. 
10 Math with internal 32-bit Calculator.  
25 EIP/PCCC Slave/server. See page 18. 
26 savvyPanel Operator station interface. See pages 13-17 
29 Solar With sun position azimuth and zenith. 
36 Motion Control With Trapezoid Motion and Cam Profile. 
50 DIN rail mount with terminal block wiring.  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speedy Stock Controllers 
Order standard option packs with four-digit model number suffix. 
 -1121 Smart Systems Controller includes -04-05-25-26, 

Process Control l ibrary and Ethernet servers; 
ModbusTCP, EIP/PCCC, and savvyPanel. 

 -1122 Smart Systems Winders and Motion includes 
-04-05-06-25-26-36, adds Winder and Motion Control. 

 speedy apps Engineered Solutions 
Generic engineered solutions include required options (in 

parentheses), system configuration, and wiring diagram. 
Contact us for many other engineered solutions. 
Compatible options may be added.  

-1101 Open-loop constant tension center winder (05, 06) 
-1102 Closed-loop dancer control center winder (05, 06) 
-1103 Closed-loop loadcell control center winder (05, 06) 
-1106 Coordinated drive, line master controller (05) 
speedy installation!
speedy is designed for permanent installation by qualified professionals.!
Environment: UL/IEC Pollution Degree 2,  

Temperature, Operating, 0°C to 50°C. Storage, -20°C to 60°C.  
Altitude 3000m max. 
Humidity 95% max. non-condensing.  

Dimensions & Clearances: 
1” clearances must be provided on three long sides 

to promote airflow.  !
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23mm 
0.91”

36mm 
1.42”

21mm 
0.83” 48mm 

1.42”

57mm, 2.24”
23mm, 0.91”

Standard Model DIN rail Mount Option



drive.web automation

speedy installation continued... 
Weight: Standard-19g(0.7oz). w/ DIN rail & terminals - 28g(1.0oz) 
Power requirements: Regulated 24VDC ±5%, 40mA.  

Do not connect to a distributed DC power network. 
External 100mA fast-acting fuse or 1A 
current-limiting is required! 

Serial port EIA485(RS485) 0.1 to 500Kbps. Unisolated. 
Power and serial circuits must have compatible 
common-mode Voltages.!

Ethernet: MDI 8P8C, “RJ45” jack, 100baseTX, 
10BaseT, Full Duplex, Auto Negotiation, Auto-
MDIX, IEEE 802.3ab.  

USB port  Peripheral-type, Micro-B jack. 
Ethernet LEDs For setup, troubleshooting and monitoring: 

100 Green LED indicates 100BaseTX Ethernet connection. 
Link / Activity Yellow LED. On for Link, flashing for activity. 

Adhesive mounting. Clean adhering surfaces with 
alcohol first. Use caution, bond is permanent. Adhere 
on or near the drive or Modbus device.   
Do not obstruct air vents, access points or product 
labels.  Do not attach speedy near AC power lines, 
hot spots, heatsinks, cooling fans, etc. 

DIN rail option. Use 35x7.5mm rail per IEC 60715, EN50022. 
Terminal wiring: Strip 7mm(0.28”) or use ferrules.  

Use 0.2mm2 (AWG24) minimum.  
One wire, 2.5mm2 (AWG12) maximum.   
Two wires, 1.5mm2(AWG14) maximum.  
Two wires with ferrules, 1mm2 (AWG18) maximum. 

Terminal tightening torque: 0.5 Nm (4.4 in⋄lbs) 
Signal wiring notes. Use twisted-pair wiring. All 

wiring outside of  the metal enclosure should be 
shielded cable with individually shielded twisted-pairs 
such as Belden 8163.  Ground the shield at only one 
end with a 360° clamp where the shield enters your 
metal enclosure. Separate all wiring from RF noise 
sources and AC power cabling.  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speedy power and serial connections!!
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24V 
0V, C 

A 
B

dw220  
Standard 15”, 24AWG,  
solid-wire connections.

DIN rail mount option. 
Single, local device 
connections.

24V 
0V, C 
A 
B

0V    24V

C 
A 
B

dw222, dw226  
RJ45

B 
A 

24V 
0V, C

YF7 
terminal

Wire 
name

SP 24V
IG and SN 0V, C
S- and R- A

S+ and R+ B

24V 
0V, C 

A 
B

dw225 

24V 
0V, C 

A 
B

24V 
0V, C 
A 
B

DIN rail option. 
Single, local 
device 
connections.

Standard 15”, 
24AWG,  
solid-wire 
connections.

Serial 
Connection

EIA485 Name Modbus 
Name

Description

A A or Data − D0 Inverting Pin

B B or Data + D1 Non-Inverting Pin

C SC or Data 0V Common Common Reference

dw223 
RJ11

A 
24V 

0V, C 
B
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speedy serial port connections continued...!
A and B must share a single twisted-pair. C may use one 

or both conductors in another pair. Do NOT pair C 
with other signals. 

EIA485 Common Reference is required. It is named C 
so that it is not confused with other common, ground 
or shield connections.   

Correct multipoint topology is daisy-chain or trunk with 
device at each end and additional devices on short 
stub branches. Star, ring, or extended branch 
topologies are NOT recommended. 

Connect line termination between A and B at both 
physical ends of  a ModbusRTU network, typically 
150Ω, 0.5W or, for networks with line polarization, 
120Ω, 0.25W and 1nF, 10V cap in series.  

Do NOT provide line termination on any network with 
an Optidrive.  

Drive setup !

dw223 Optidrive Plus notes!
Check drive model number and firmware version. 

P0-28 and P0-29 should indicate 2.2 or higher. 
Model number must end in -M for firmware versions 
prior to 3.0.  

speedy 
model

Supported 
drive

Required drive settings Related drive 
settings

dw220 Generic Baud-rate, framing Serial loss behavior
dw222 OptidriveE2 P-36; Address = 1, 

Baud rate= 115.2Kbps
P-36, Comms Loss 

Trip Enable
dw223 OptidrivePlus P2-26, Baudrate = 

115.2Kbps 
P2-27, Address = 1

P2-26, T, trip or R, 
ramp on serial 
loss

dw225 YaskawaF7 H5-01 = 1F, decimal 31 
H5-02 = 4, 19.2Kbps 
H5-03 = 00, No parity 
H5-06 = 05, Min. delay 5ms

H5-04 Stopping 
Method 

H5-05 Serial Fault 
Detect

dw226 OptidriveHVAC P-36; Address = 1, 
Baud rate= 115.2Kbps

P-36, Comms Loss 
Trip Enable
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Drive setup continued...!
dw225 Yaskawa YF7 notes 

Check Flash ID, U1-14 = 3020.  
Check internal line termination switch S1-1. 
Cycle YF7 power, wait for the screen to blank before 

re-powering, for parameter changes to take effect. 
Set up your computer - get savvy 
With free drive.web savvy software, easily program and 

monitor speedy, perform data trending, and create 
distributed control systems. 

To download the latest version of  savvy, go to 
www.driveweb.com and click on get savvy. 

Java Runtime Environment must be installed to run 
savvy. There is a link on the get savvy page to 
download Java for free.  

If  you do not have internet access, install savvy and 
Java from the Bardac Infodisk. Browse to the 
savvy link, off-line installation. Contact us for the 
files or Infodisk.  

speedy USB - plug and play 
Experience plug-and-play access to speedy and its local 

Ethernet network. Requires 0x201A firmware or 
later. Contact us for details. 

speedy Ethernet networking & programming 
Before proceeding, it is important to have a basic 

understanding of  Ethernet TCP/IP networks. 
Assigning an invalid or duplicate IP address will cause 
serious network malfunctions!  

Find useful networking information. Under the Help 
menu click on Getting Started with savvy section.  

speedys are all shipped with the same IP address, 
10.189.189.189. Consult your company’s IT 
department for an appropriate, unique IP address.  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Ethernet Network Requirements 
A standard Category 5e cable with 8P8C/RJ-45 

connectors on both ends for each drive.web  device 
and the host computer. 

For systems with more than one drive.web device, an 
Ethernet switch with ports for all drive.web devices 
and your computer. 

Get started with savvy 
We strongly recommend attending our free on-line 

training seminars. To register and get your invitation, 
call or e-mail training@driveweb.com. 

Before proceeding with your systems designs it is very 
important to familiarize yourself  with savvy, the 
configuration software.  

We strongly recommend you read the User Manual 
and Getting Started Guides under the Help menu.    

Use Create Phantom in the Directory menu to 
practice, explore all drive.web products and options 
and design and configure off-line. Design systems in 
Phantom devices and Export Data under the 
Directory menu for later use in live devices. Import 
Data into  phantoms to work off-line.  

savvy Window Title Bar indicates the current view. 

Status Bar, above the viewing area, provides 
Navigation Arrows and object and location data. 

savvy views are hierarchical with the Device 
Directory View at top. Use the Navigation 
Arrows to view the next higher level or go backward 
and forward through views. Note that window menus 
change as you navigate.  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Get started with savvy continued... 

Hover cursor over active object, device, function 
block, connection, or parameter icon to view object 
information in the Status Bar and reveal a Hover 
Button. 

Click a Hover Button or right-click an active object 
to access a Contextual Menu. See below. 

savvy functionality may be limited if  you do not 
have the required password-protected capability level 
(see File > Capability...) or a device is locked with a 
password (see contextual menu below). 

Device Directory Window  

Warning! Changing a device IP address WILL disrupt its 
network connections! If  a speedy is communicating 
with other devices or drives you must be prepared for 
system disruption and to remap connections in those 
devices when changing an IP address. In the File 
menu choose Utility > Remap Export File to 
remap a dw-system file with different IP address(es). 

Select File > Administrate > Set IP Addresses 
for System.   

The serial number marked on your smarty is its 
MAC Address.  

Enter a unique IP address within your computer’s 
subnetwork, click OK.   

A speedy icon should appear with IP address beneath. 
With drive-dedicated models, the graphic depicts the 
actual frame size of  the drive. 

If  the icon at right appears, a network connection 
problem exists. Check connections, LEDs, and that 
the speedy  IP address is within your computer’s 
Ethernet subnet mask.   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Get started with savvy continued... 

Device Directory Window - Directory Menu.  !

Discover via USB... Perform basic operations without 
needing to configure your computer’s Ethernet port. 

Discover by IP Address... Anywhere on the internet, 
locally or  via a public IP address, VPN or similar.  

Warning! Importing a configuration into your speedy 
will result in immediate execution of  that 
configuration. Dangerous Voltages and rotating 
machinery may result! Use a phantom to preview 
a configuration. 

Import / Export Data. All device configurations 
and drive.web connections between devices in 
the directory. All in one .dw-system file.  

speedy Icon Contextual Menu  

Change Name. Name your speedy for easy 
identification.  

Import / Export Device Data... Load / save 
configuration data to / from this speedy only. 

Find Parameter... Enter parameter number, name, or 
partial name to view it. 

Unlock, Lock, Set Password. The speedy at top-
right is locked to Restrict Modification. Viewing 
configuration is possible. The speedy below it is 
locked to Restrict All Access. Select lock type when 
setting password. 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Get started with savvy continued... 

Click the speedy icon to view the Device Overview 
(Standard savvy, no SFD). Find the Function 
Block Engine icon and, if  options 04 or 25 are 
present, the Comms Server icon, at top-right.  

Function Block Engine Window - FBE Menu 
(Standard savvy, no SFD),  

Add function blocks in the order to be processed. 
Processing order is left to right, top to bottom. 

Click function blocks to view parameters and details.  

Connect between parameters and to parameters in 
other drive.web devices over Ethernet.  

Warning! Making a connection results in immediate 
execution of  that connection. Dangerous Voltages 
and rotating machinery may result!. 

Under the File menu, choose New Viewer... and 
then, File > Open Device Directory.  

With two viewer windows, click on a parameter, 
drag a connection, and drop onto a 
destination parameter in the other viewer.    

Parameter Contextual Menu!
Most parameter data is 16-bit. Raw decimal integer 

values 0 to 65535 or ±32767. Data is formatted, 
limited, and scaled depending on the parameter.  Use 
Get Info or Re-Scale... to verify or change. 

Click parameters for the Setter Box Adjust value 
with convenient graphical buttons or keyboard entry. 
Also find buttons for return to default or last state. 

Click blue connection block or arrow to jump to 
other end. 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Upgrade savvy and speedy 
Upgrade savvy with SFD Signal Flow Diagram.  
Upgrade speedy with software options.  
Process credit cards or Vouchers on-line or Coupons off-line.  

To upgrade savvy go to the Commerce menu, select 
Upgrade savvy, check desired options, click OK. 

To upgrade speedy, choose Upgrade Device… in its 
contextual menu, check desired options, click OK. 

Your selected options will appear in the Shopping Cart. 
Select your method of  payment. 

To process Vouchers, choose Pay>Online Via 
Vouchers in the Shopping Cart. Enter 
Voucher codes on separate lines. 

To process Coupons click Buy and forward the 
code to your drive.web distributor. When you 
receive your coupons go to the Commerce 
menu and choose Coupon Manager. Enter 
codes in the top box and click the Add button. 
Click Apply. 

savvy-SFD Signal Flow Diagram Upgrade 
With savvy-SFD, build systems graphically. The live 

drawings are stored in your speedy.   
Set drawing borders and annotate multi-page drawings.  
A filterable list of  function blocks and connections is at 

the left of  the Signal Flow Diagram showing 
program execution order from top down. The 
order in which function blocks are processed can 
greatly influence system performance and the 
function of  logic engines.  
Change execution order by dragging function blocks 

up or down the list. In this picture, ENC1 Speed 
function block and its outgoing connection will be 
moved so that they are processed after ENC 
Phase Lock. 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savvyPanel Operator Station!
Computers, Apple® mobile digital devices; iPad®, 

iPhone®, and iPod Touch® are operator touch 
stations with savvyPanel. Requires Windows(XP, 
Vista, 7), Mac OS X, Linux-based Ubuntu, or iOS®. 

Operator station configurations are stored in 
the drive.web devices. 

Editing and building savvyPanel systems 
requires savvy-SFD upgrade. 

dwOption-26 savvyPanel, must be 
installed in drive.web devices to enable 
the full suite of  tiles. A limited set is 
available without the option.  

Find complete information on savvyPanel 
in the savvy User Manual. 

Get savvyPanel free from the Apple App Store℠!
When your iPad or iPhone is connected to the internet 

via WiFi, Demo Mode connects to a live drive system 
in our plant in Maryland, USA. 

Touch Roll Change button to reset the roll length. 
Enable all section switches; extruder, brake, winder, 
Touch the Line Start button and watch the line 

accelerate, run, and then automatically slow to stop 
at the required length. 

Touch Set Speed, Set Temp or Set Tension to open 
the setter and make changes. 

Touch the parameter name in the setter to get info 
Touch page-link arrows to browse demo pages. 
Explore the demo with savvy on your computer. In the 

File menu, choose Demo Mode > Discover 
Internet Demo Devices. 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drive.web automation

savvyPanel Pages!
Systems Page is available when multiple savvyPanel 

systems are discovered.  
Each savvyPanel system may contain tiles from 

many drive.web devices.  
Each drive.web device may contribute to only one 

savvyPanel system. 
Touch the systems button,     or     , in the window bar 

to access the systems page from home page. Lock this 
button with home password. 

Home Page is the first operator page in a savvyPanel 
System. 

Access home page from any operator page with the 
home button,      . Lock with the home password. 

Operator Pages show graphic, page-link, and 
parameter tiles.  

Pages can be renamed. The name appears in the 
window title bar. 

savvyPanel Tiles!
Parameter Tiles Touch a settable parameter to see its 

savvyPanel Setter. Includes slider, keypad, 1x, 10x 
increment, default, and revert.  

A parameter is settable if  it is not read-only and has no 
incoming drive.web connection. 
Meter Digital panel meter, dial, or bar meter. 

Unipolar, bipolar, full-scale, and percent choices. 
Indicator Variety of  colors. Shows on/off, true/false  

boolean state. All non-zero values are true. 
Pushbutton Momentary actuators in a variety of  

colors, also lighted Start/Stop. 
Multi-position Switch For enumerated parameters.  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!
savvyPanel System 
Example !!

Discover devices when savvy 
launches or by using the 
Directory menu. Discover by;  
group, savvyPanel system, 
Discovery file, or all local 
devices automatically.

Device Directory

Function Block Engine
With standard savvy, the device 
overview screen gives access to 
Comms Server setup, Function 
Block Engine, and native device 
functions where applicable.  
With savvy-SFD place function 
blocks graphically. Use function 
block list to review and arrange 
execution order.

Function Block
View functional elements and 
signal paths in relation to 
parameters. Parameters show 
type, drive.web connections, 
read-only and not at default 
adornments.  

Add parameters of  interest to set, 
view, create trend graphs, and 
export .csv files for spreadsheets. 
Save docks and open multiple 
docks in different viewer 
windows.

Parameter Dock

Navigate 
Up 

Arrow

savvy overview
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Systems Page
View all available 
savvyPanel systems.  
Assign a savvyPanel system 
in each device’s contextual 
menu, one per device.  
If  a savvyPanel password is 
set in the device, it must also 
be added in savvyPanel 
operator station software.

Home Page
The first page in a 
savvyPanel system.  
Similar to Operator Pages 
except that it may be accessed 
from any Operator Page by 
pressing the Home button. 
Touch page-link tiles to go to 
Operator Pages.

Up to 256 possible. May be 
page-linked in any way.  
Set savvy preferences so 
that operators view a specific 
page at launch. Restrict 
access to the Home Page and 
pages linked only from the 
Home Page with the Home 
Password. Provide links to the 
home page to bypass the 
home password.  
A page-link to the Home 
Page bypasses the Home 
Password.

Operator Pages

Systems Button.  
Requires Home Password if  set.

Home Button.  
Requires Home Password if  set.

savvyPanel overview
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savvyPanel Tiles continued...!
Graphic Tiles Create diagrams with process elements. 
Page-Link Tiles A graphic tile that is also a page-link.  

Touch to change the view to that page.!
Device Tiles Link to device’s signal flow diagram in Java-

based savvyPanel. Appears as graphic tile in iOS.!
Function blocks enable savvyPanel actions!
Alarm Annunciator Provides a system-wide alarm 

annunciation when active. Touch to view page 255. 
Presence Monitor Indicates the presence of  a tagged 

savvyPanel application viewing a particular page. 
Latch and SR Latch for lighted start-stop pushbuttons.  
Setpoint & Monitor blocks control meter range. 

Setpoint clamps setter. Dual blocks enable dual-
display meters 

Enumerated Parameter block in Utility group. Only 
custom enumerations appear in the setter and multi-
position switch. 

savvyPanel launch, setup and important notes!
See the savvy user manual for detailed instructions. 
Launch savvyPanel via command line or batch file.  
Limit operators to savvyPanel only. Specify start 

system and page. 
Discover devices automatically, specifically by discovery 

file, or filtered by group and/or savvyPanel name. 
Operator’s note: If  communication with a drive.web 

device is interrupted, affected tiles indicate a yellow 
bar at top with an exclamation warning. The 
displayed value is not updated. 

dw215 YF7-native parameters are not supported. 
Connect to function block engine for savvyPanel. 

Important Design Note An over-range enumeration is 
required if  misreading an out-of-range value could 
cause a hazard.  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speedy Comms Interfaces-Modbus & EIP/PCCC!
Warning! Use of  speedy comms interfaces, ModbusTCP, 

ModbusRTU and EIP/PCCC, may cause motors and machinery 
to energize with high Voltages or start or operate in an 
unexpected, dangerous or lethal way. It is essential that you are 
completely familiar with the Ethernet server protocol, equipment, 
and the system design before use of  these options. It is also 
essential that a risk assessment is conducted to identify hazards 
and that risks are reduced to tolerable levels. 

For Modbus specs go to http://modbus.org/specs.php 
Boolean values are 0 or 1. Non-zero values are Boolean true.  

speedy Ethernet server support, options 04 & 25!
Note! You cannot write or force parameters that are 

read-only or have incoming drive.web connections. 
Click the Comms Server icon in the FBE or SFD view. 

speedy option 04 ModbusTCP/IP slave/server!
ModbusTCP Slave Port 502 is the standard specified 

in the protocol. 
Supported Modbus Function Codes; 1 thru 6, 15, and 16. 
Supports up to five simultaneous clients/masters.  

speedy option 25 EIP/PCCC Server!
Supports PLC5 Typed-Write and Typed-Read commands. 
See Appendix B of  the savvy User Manual for 

information and drive.web parameter IDs mapping 
to PLC5 file numbers and register addresses. 

Supports up to two simultaneous clients.!
ModbusRTU Master & bus-share drive interface!
Adding network devices may affect serial link performance 

with drive-dedicated devices. 
Modbus Function Codes FC 01-06 and 16 are 

supported. Also special Yaskawa Holding Register. 
A device Modbus address must be unique on the network! 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drive.web Product Line Highlights 
Drive-dedicated smarty and speedy models: 

smarty DIN rail drive.web controller.   
Sixteen flexible, bipolar-analog / digital I/O 
Hardware options; dual serial-ports, add six digital inputs, 

frequency I/O, relay-rack, dual stepper control. 
External options; remote, dual encoder module with re-

transmit, high-Voltage I/O. 
Encoder control; cyclic and linear positioning, electronic 

line shaft, registration, event counts 
savvy-SFD Signal Flow Diagram upgrade, see page 13. 
savvyPanel operator touch station app, see pages 14 to 17. 
drive.web products are designed & assembled in the U.S.A. 
Get drive.web help. Call or email techsupport@driveweb.com 

drive.web training courses  
Free online interactive training seminars take about one hour.  
Specialized online and factory training sessions are also available.  
To register email training@driveweb.com or call.

Supported Drive smarty  Model speedy  Model
Generic dw210 dw220
PL/X Digital DC Drive dw211 dw221
Optidrive P2 dw214 dw224
Optidrive Plus dw213 dw223
Optidrive HVAC dw216 dw226
Optidrive E2 dw212 dw222
Optidrive E2 Single Phase Output dw212 dw222
YaskawaF7 dw215 dw225
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